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Abstract

Over the past 3 decades the zebrafish (Danio rerio) has become an important biomedical research 

species. As their use continues to grow additional techniques and tools will be required to keep 

pace with ongoing research using this species. In this paper we describe a novel method for in vivo 

imaging of the retinal vasculature in adult animals using a commercially available confocal 

scanning laser ophthalmoscope (SLO). With this instrumentation, we demonstrate the ability to 

distinguish diverse vascular phenotypes in different transgenic GFP lines. In addition this 

technology allows repeated visualization of the vasculature in individual zebrafish over time to 

document vascular leakage progression and recovery induced by intraocular delivery of proteins 

that induce vascular permeability. SLO of the retinal vasculature was found to be highly 

informative, providing images of high contrast and resolution that were capable of resolving 

individual vascular endothelial cells. Finally, the procedures required to acquire SLO images from 

zebrafish are non-invasive, simple to perform and can be achieved with low animal mortality, 

allowing repeated imaging of individual fish.
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1. Introduction

The zebrafish, (Danio rerio), has become a popular experimental animal for basic research 

(Bilotta and Saszik, 2001; Hughes, 2013). The number of publications using this species has 

grown over the past three decades with over 20,000 publications currently available online. 

Although the use of rodents is still more prevalent (Hughes, 2013), a PUBMED search by 
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our group revealed that publications using zebrafish are currently outpacing those using 

mice, rats and Drosophila (unpublished data). If this rate continues, the number of zebrafish 

publications could potentially eclipse those of Drosophila and rodents in the future.

Zebrafish offer a number of advantages that make them more convenient and less expensive 

to use in research than other vertebrates. They are easy to breed (Kari et al., 2007), and 

much less expensive to maintain than rodents (Vogel and Weinstein, 2000); they reach 

maturity within 3 months and are easily manipulated for production of transgenic and 

mutant strains; and as a vertebrate, 70% of human genes have at least one ortholog in 

zebrafish (Howe et al., 2013). The animal is robust and easily manipulated considering its 

small size and unique aquatic environmental requirements.

Zebrafish are substantially smaller than mice and the ocular system is proportionally smaller 

as well. The dimensions of adult zebrafish pupil and lens are approximately 1 mm in 

diameter (Dahm et al., 2007; Farkas et al., 2010) making imaging of the fundus through the 

pupil rather challenging. New approaches have recently emerged for imaging ocular tissues 

from both adult and embryonic zebrafish. To date fish have been successfully imaged in vivo 

with confocal SLO (Farkas et al., 2010), fundus imaging (Duval et al., 2013; Tschopp et al., 

2010), OCT (Bailey et al., 2012; Kagemann et al., 2008; Podoleanu et al., 2008; Rao et al., 

2006) and traditional confocal microscopy (Watanabe et al., 2010). Extraocular confocal 

imaging of the zebrafish eye has been described in embryos for vascular angiography 

(Weinstein et al., 1995) and retinal cell morphology (Watanabe et al., 2010). Whole embryo 

OCT imaging has also been used to follow the development of ocular structures (Kagemann 

et al., 2008). To our knowledge, this is the first report describing the use of a commercially 

available clinical instrument to acquire SLO images from the adult zebrafish eye in a 

transpupillary manner.

Scanning laser ophthalmoscopy (SLO), first reported by (Webb et al., 1987), is now a well-

established clinical imaging technique in ophthalmology (Hassenstein and Meyer, 2009). 

The clinical instrument has also found wide use in non-clinical research for imaging eyes in 

small animal models (Hossain et al., 1998; Seeliger et al., 2005). SLO is capable of 

visualizing endogenous features of the retina as well as exogenous signal from fluorophores 

injected into the systemic circulation as they enter retinal vessels (Seeliger et al., 2005), 

protein labels for visualization of photoreceptors (Beck et al., 2010; Seeliger et al., 2005), 

inflammatory monocytes (Paques et al., 2006), and apoptotic cells (Maass et al., 2007). 

Building on these previous examples in other research animals, we decided to investigate the 

feasibility of imaging retinal vessels in zebrafish using a commercially available SLO. This 

paper describes in detail our experience with SLO in transpupillary imaging of retinal 

vasculature and provides examples of images that can be routinely obtained from 

anesthetized adult zebrafish.

2.0 Materials and Supplies

2.1 Animal Models and Care

All manipulations conformed to the ARVO Statement for Care and Use of Animals in 

Ophthalmic and Visual research. The Cleveland Clinic Institutional Animal Care and Use 
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Committee approved all experimental procedures and manipulations.. Adult zebrafish used 

were maintained at 28.5°C on a 14-hour light/10-hour dark cycle according to standard 

procedures (Westerfield, 2007). Fish, 3 – 15 months old were used for the studies described. 

Zebrafish lines examined by SLO imaging included Tg(flk1:EGFP)(Jin et al., 2005), 

Tg(flk1:mCherry), Tg(flk1:nGFP), Tg(l-fabp:DBP-EGFP) (Xie et al., 2010) and 

Tg(apoeb:lynEGFP)zf147 (Matthews and Varga, 2012; Peri and Nusslein-Volhard, 2008). 

In the Tg(flk1:EGFP) and Tg(flk1:mCherry) models, EGFP and RFP (mCherry) are 

expressed in the cytoplasm of vascular endothelial cells while Tg(flk1:nGFP) zebrafish 

express GFP in the nuclei of vascular endothelial cells. In the Tg(l-fabp:DBP-EGFP) model, 

the fluorescent vitamin D binding protein (DBP) is fused with EGFP. DBP is a member of 

the albumin gene family and found in plasma. DBP-EGFP fusion protein is synthesized by 

hepatocytes and secreted into the blood plasma compartment. Tg(apoeb:lynEGFP)zf147 

zebrafish express EGFP in Müller glia of the neural retina.

2.2 SLO Instrumentation

Retinal imaging was performed using a Heidelberg Retina Angiograph 2 (HRA2) SLO, 

which is the predecessor to the Spectralis® family of ophthalmic imaging instruments 

currently available from Heidelberg Engineering USA, Inc (Carlsbad, CA). The HRA2 has 

two primary settings, known as “R” and “A”, which refer to reflectance and angiography 

modes of operation, respectively. A lever on the scan head allows alternation between these 

two modes of operation. Within these modes are several additional imaging channels that 

can be deployed using various combinations of illumination and/or acquisition parameters. 

Each channel is uniquely independent and permits probing with specific illumination and/or 

excitation wavelength parameters. As a result, this instrument can be used to non-invasively 

monitor tissue changes over time using 5 separate channels, with each channel providing 

unique information about the tissue being examined. The various modes and sub-mode 

channels are shown in Table 1.

With the instrument in “R” mode, reflectance images are collected via two channels that are 

referred to as Red Free-Dark Field (RFDF) and Infrared-Dark Field (IRDF), respectively. 

Red Free and Infrared refers to laser illumination wavelengths of 488 and 815 nm, 

respectively. The term “dark field” refers to images that are collected using crossed (i.e. 

orthogonal) polarization filters in the illumination and signal detection arms of the 

instrument. As the instrument scans the retina, a two-dimensional fundus image is generated 

from the reflected signal collected in retro-fashion. The visual contrast observed in dark 

field images originates predominantly from the birefringent properties of the tissue 

(Heidelberg Engineering, 2006, 2008).

In “A” or angiography mode, the instrument is capable of collecting both autofluorescence 

and reflection data, in addition to typical endogenous and exogenous fluorescence signals 

from injected fluorophores as well as GFP signals (Paques et al., 2006). This mode permits 

image collection from 3 separate channels, each with excitation/illumination wavelengths 

centered at 488 or 790nm. The three channels are referred to as FA, ICGA, and IR, which 

correspond to Sodium Fluorescein Angiography, Indocyanine Green Angiography and 

Infrared reflectance, respectively. Used in the absence of exogenous fluorophores (i.e. NaF, 
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ICG, or GFP), FA and ICGA channels are often referred to by different nomenclature, which 

are AF (blue/green autofluorescence @ 488 excitation) and IRAF (infrared autofluorescence 

@ 790nm excitation). For quality control, SLO excitation and illumination laser intensities 

are periodically measured using a calibrated Nova optical power/energy readout unit (Ophir-

Spiricon LLC, N. Logan, UT) and optical power detection head (PD300-3W).

All images were collected using the wide-field objective lens (55°). For single frame images 

the system was operated in high-resolution mode, which provided nominal field of view 

options of 55° (~ 1.9 MP), 35° (~1 MP), and 25° (~0.59 MP) with acquisition rates of 5, 7 

and 9 frames/sec, respectively. Dynamic imaging (i.e. movies) was performed with the 

system set at high-speed mode, which provides nominal field of view options of 55° (0.46 

MP), 35° (0.26 MP), and 25° (0.15 MP) with acquisition rates of 9, 13, and 16 frames/sec, 

respectively. The HRA2 system was operated under Heidelberg Eye Explorer software v1.7. 

Online algorithms within the HRA2 control software enable automatic real-time averaging 

and tracking (ART) of sequentially collected images. This parameter was preset for 25 

frame averaging to further enhance image contrast and resolution with all imaging sub-

modes. A manual, z-axis, focus adjustment (Range −20 to 200 D) on the system permits 

linear adjustment of the SLO confocal axial imaging plane within the ocular tissue. The 

adjustable focus feature was used extensively to identify and document vasculature features 

observed in the various zebrafish models investigated.

In order to better facilitate imaging of a small animal model, we removed the head/chin rest 

from our instrument that is provided for clinical use and replaced it with a mounting stage 

designed for animal use (Heidelberg Engineering USA).

2.3 Image Processing, Data Analysis, and Statistical Analysis

2.3.1 General Information on the Acquisition, Exporting and Display of Images
—All images were collected with the automatic normalization and brightness features 

inactivated in the HRA2 acquisition software. Single and composite images were exported 

as uncompressed, 8-bit TIFF files. Dynamic recordings were exported as uncompressed AVI 

files. ImageJ (v1.47b) software (Rasband) was used to open exported files for post-

collection processing and analysis. By default, the images open (File>Open) as RGB color 

files in ImageJ and were converted to 8-bit grayscale images (Image>Type>8-bit). Scale 

bars displayed in the exported images, which are calibrated for human ocular dimensions 

and not zebrafish, were removed [Color Picker (R, G, B values = 0, 0, 0) & Pencil Tools 

(size 20)] from the lower left corner. ImageJ was used to enhance brightness and/or contrast 

(Image>Adjust>Brightness/Contrast>Auto) as well as pseudocolor (Image>Lookup 

Tables>Green) some angiography images post-acquisition to better accentuate GFP, EGFP 

or RFP fluorescence. This was performed strictly on representative images intended for 

display in the manuscript (Figs. 1C–E, J–L) so that minute detail could be visualized. In 

contrast, all quantitative analysis (Table 2 and Figs. 2–4) were performed on unaltered TIFF 

images. No corrections or adjustments to signal intensity and/or contrast were made prior to 

performing avascular space area and background intensity level measurements.
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2.3.2 Vascular Anatomy and Background Amplitude Comparisons between 
Zebrafish and Mice—Images from Tg(l-fabp:DBP-EGFP) zebrafish and mice injected 

with NaF were obtained to compare retinal vasculature anatomy between species. The 

description of SLO and/or fundus imaging using NaF for mouse vasculature has been 

previously published (Paques et al., 2006; Seeliger et al., 2005). This technique is used 

frequently in rodents in vivo to assess vascular leakage from retinal vessels (Xia et al., 2008) 

and laser-induced choroidal neovascularization (CNV) in vivo (Balaggan et al., 2006; 

Luhmann et al., 2009). Briefly, for our studies, mice were injected with 10 μl of 1% NaF 

intraperitoneally (IP) and imaged 4 minutes later using FA mode. Images of the deep and 

superficial vascular plexus, described by Paques et al (Paques et al., 2006;), were obtained 

by adjusting the SLO scan focus and using ART and 25 frames averaging.

Extravascular Space Mean Intensity (ESMI) and Area (ESMA) from both species were 

measured using the following image processing steps in ImageJ. Images were exported, 

opened and converted to grayscale images as aforementioned in 2.3.1. Afterwards an 

automated threshold function (Image>Adjust>Threshold>Auto with the following selections 

“Yen & Red”>Apply) in ImageJ, which we have abbreviated as “YAT”, was applied to 

isolate the avascular space for analysis. After running the function, the retinal vasculature is 

preserved in grayscale and the image window frame (i.e. black mask surrounding the 

circular SLO FOV) and extravascular spaces become highlighted in red. To further isolate 

the ROI (circular FOV region) from the image frame mask, the lower limit arrow tab in the 

ImageJ Threshold function window must be changed from “0” to “1”. This step changes the 

image mask from red back to black and fully isolates the avascular space from the 

vasculature and image frame mask.

Next, immediately prior to collecting the area and intensity measurements, the image scale 

was set to default in pixels (Analyze>Set Scale>“Click to Remove Scale”) and the “Area”, 

“Mean”, “Area Fraction” and “Limit to Threshold” boxes were selected within the “Set 

Measurements” window (Analysis>Set Measurements> select “Area”, “Mean”, “Area 

Fraction” and “Limit to Threshold”). The ESMI and ESMA were then obtained using the 

measure function (Analyze>Measure>Results).

2.3.3 Quantification of Vascular Leakage Following Intraocular Injections—A 

procedure was developed to measure and quantify signal changes from the avascular space 

of Tg(l-fabp:DBP-EGFP) zebrafish following intraocular injections (IOI). For these 

experiments, FA images were acquired with a camera sensitivity (i.e. gain) setting of 70 

from a possible range of 31-107. In the majority of fish (>80%) at baseline, optimal images 

could be obtained using this setting without evidence of image pixel saturation, which 

coincidently, occurs at a grayscale level of 251 and is revealed to the operator by colored 

pixels on the display screen (Charbel Issa et al., 2012). If saturation was observed, either 

from avascular leakage or from the bright, EGFP laden vessels (most notably from the 

vascular trunk region), a series of additional images (3 minimum, but up to 6 if saturation 

was still observed at lower sensitivities) were collected using lower sensitivity settings taken 

at half-decade increments (i.e. 65, 60, 55, 50, etc.). Images (e.g. 70 only if unsaturated) 

and/or image sequences (e.g. 70, 65, 60 and so on if saturation was noted) were then 

exported to ImageJ as aforementioned in 2.3.1 and were analyzed using the YAT function 
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described in 2.3.2. For animals without saturated images the analysis was straightforward 

and identical to that described in 2.3.2. Animals with saturated images at a sensitivity setting 

of 70 underwent a correction process developed to address the 8-bit dynamic range 

limitation of the SLO detection system. The sensitivity of the HRA2 and Spectralis family of 

instruments has been previously reported to have an exponential change in signal gain 

relative to the linear change (31-107) in sensitivity setting via the console selection dial 

(Delori et al., 2011). Knowing this information we were able to devise a correction process 

for analyzing saturated images from animals that had more fluorescence yield at baseline or 

any other time point (e.g. from EGFP expression yield and/or size/volume of vascular head 

which typically happens to be the brightest object in an image) or exhibited an exceptional 

amount of leakage signal that exceeded the 8-bit dynamic range of the HRA2 camera at a 

sensitivity setting of 70. With these particular animals, each additional sub half-decade 

image was opened in ImageJ, converted to grayscale, and then double-checked for evidence 

of pixel saturation using the Histogram function (Analyze>Histogram). The first non-

saturated image identified (e.g. say 65 for example), and the two following lower sub half-

decade intensities (e.g. 60 & 55) had the YAT function applied to them to obtain the ESMI. 

Mean pixel signal amplitudes from the unsaturated, tri-image sequence (e.g. 65-60-55) were 

then plotted in MS excel. In excel these data points were fitted with an exponential curve to 

obtain the fit parameters (i.e. equation constants). The equation was then used to extrapolate 

the mean extravascular signal value at a sensitivity setting of 70.

2.3.4. Procedure Times—Zebrafish preparation and imaging times were obtained from a 

group of 35 animals and displayed as Mean ± S.D.

2.3.5 Statistical Analysis—Data were plotted and analyzed for statistical significance in 

Graphpad Prism v6 using ordinary one-way ANOVA and multiple t-test. P-values of ≤0.05 

were considered significant. In figures and tables, P-values are denoted using asterisks as 

follows: *P≤ 0.05, **P≤ 0.01, ***P≤ 0.001, ****P≤ 0.0001.

3.0 Detailed Methods

3.1 Zebrafish Sedation

Fish were individually anesthetized using ethyl 3-aminobenzoate methanesulfonic acid salt 

(Product #118000500, Acros Organics, Morris Plains, NJ), also known as “MS-222” or 

“tricaine”, as previously described (Matthews and Varga, 2012). We found it convenient to 

make Tricaine stock solution (100 ml) in bulk, aliquot it into smaller volumes (10 ml), 

stored at −20°C, and thaw as needed on a weekly basis. Tricaine stock solutions (4% w/v) 

were made by combining 97.9ml of double distilled water with 2.1 ml of 1 M Trizma base 

(Sigma Life Sciences T1503-1KG, MW: 121.14 g/mol) (12.114 g/100 ml H2O) and 400 mg 

Tricaine powder. After thawing, stock solutions can be refrigerated at 4°C between uses for 

up to 5 days. Immediately before use, a “starter” Tricaine anesthetic solution was prepared 

by adding 2 ml of the 4% Tricaine stock to 100 ml of clean fish tank water. Fish were then 

placed in the anesthesia solution contained in a 250 ml glass beaker and closely monitored 

for several minutes for changes in swimming behavior, righting reflex and gill plate 

movement. Fish were considered ready for imaging when they showed no evidence of 
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movement and did not respond to touch or handling. In our experience, ~3 ml of Tricaine 

stock added to 100ml of tank water (~0.12% or 0.120 mg/ml) is sufficient to induce short 

term anesthesia, however, we have successfully employed Tricaine doses ranging from 

0.120 to 0.170 mg/ml.

3.2 Intraocular Injections

For vascular leakage experiments, zebrafish were anesthetized with Tricaine and intraocular 

injected (IOI) through the superior-nasal sclera using a pulled glass capillary pipette (30 μm 

diameter) and syringe pump (PV830 Pneumatic Picopump, World Precision Instruments, 

Sarasota, FL). In the first experiment, 0.8 μl (20 ng) of Bovine Serum Albumin (BSA) 

(Product# A7030, Sigma-Aldrich) reconstituted in phosphate buffered saline (PBS) 

containing 0.005% NaF was administered once to the right eye 24 hours after baseline 

imaging. In a second experiment, 0.8 μl (20 ng) of BSA in PBS was administered once to 

the right eye 24 hours after baseline imaging. A second group of animals was imaged daily 

and served as non-injected controls. In a third experiment, 0.8 μl of three different 

concentrations (20, 40, & 80 ng) of Bradykinin (BDK, Catalog #3004, TOCRIS Bioscience, 

Minneapolis, MN) reconstituted in PBS was administered once to the right eye 24 hours 

after baseline imaging. For an injection control, 0.8 μl (20 ng) of BSA in PBS was 

administered once to the right eye in a separate group of animals.

3.3 Pre-imaging Preparation

Once immobilized, which took on average 311 +/− 127 seconds, fish were removed from the 

250 ml beaker using a plastic ladel and placed on a customized holder. The holder 

dimensions are 1.3 cm (W) × 3.5 cm (L) × 1 cm (H) constructed from a silicone finger mat 

(Item #1502E, Ambler Surgical, Exton, PA). The silicone fingers (i.e. vertical posts) enable 

positioning of the fish in the normal swimming orientation (Fig. 1A). The right eye was 

lightly touched with the tip of a cellulose sponge (Keraspear, Medtronic Xomed, Inc. 

Jacksonville, FL) to remove excess water from the cornea. The PMMA contact lens 

(Ø=5.2mm, r = 2.7mm, center thickness = 0.4mm, Cantor & Nissell, Ltd., 

Northamptonshire, U.K.) was picked up with small curved forceps and a single drop 

(~20ml) of Systane® Ultra hydrating tears (Alcon Laboratories, Ft. Worth, TX) was applied 

to the concave surface. The contact lens was then placed on the eye and manually held in 

position for a moment (~3 s) until adherent via surface tension. The process of removing the 

fish from the anesthesia solution, position in the holder and applying the contact lens can be 

accomplished in approximately 30 seconds.

3.4 Transpupillary SLO Imaging

The holder containing the fish with applied contact lens is then moved to the SLO imaging 

platform (Fig. 1B), (CL2 Table Clamp, Thorlabs, Inc., Newton, NJ) and held in place with 

double-stick tape (3M, St. Paul, MN). The holder is attached to an adjustable camera ball 

mount (SLIK model SBH-320, THK Photo Products, Huntington Beach, CA) in order to 

align the eye for imaging. Imaging of the right eye only requires 198 +/− 59 seconds and 

will vary depending on the number of images collected.
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Imaging of inner retina, including the surface retinal vasculature and nerve fiber layer, is 

best accomplished with an internal myopic lens (−12 Diopter) correction set via the HRA2 

control panel. This setting adds some divergence to the normally collimated SLO laser beam 

emerging from the instrument and when focused by the cornea and lens, extends the laser 

focus plane further into the ocular tissue. Extending the focusing depth enables one to reach 

the plane of interest (i.e. retinal vessels) by changing the focus adjustment knob on the SLO 

scan head. Performing this focusing exercise on each fish ensures that the best image plane 

is identified.

To acquire images immediately post-injection (IPI), additional myopic corrections are 

necessary to visualize the vascular plexus, which is displaced and/or distorted by the IOI. 

This adjustment extends the scanning laser focal plane further into the retina. This requires 

an atypical change to the myopic lens position in the SLO scan head via an engineering 

service mode diagnostics window (Note: Should one have hesitation regarding this simple 

change they should contact Heidelberg Engineering Technical Support for guidance). 

Briefly, to perform this adjustment, it is necessary to have the HRA2 system running with a 

live imaging window open and actively scanning. It is best to do this well before a fish is 

ready to be imaged as this routine can take up to a minute to perform. Depress the following 

keys (CTRL>ALT>SHFT>D) on the keyboard to open the service window. The Z module 

adjustment is located in the upper right hand corner of this window. The typical home 

position of the Z module is ~260 and it will need to be reduced to a value that can range 

from 150–240 using the “<<” and “<” selections. (Note: Care should be taken when 

venturing beyond a setting of “0” as the translation stage that advances the myopic lens 

assembly may get stuck and not retract with the usual commands. Should this happen it is 

necessary to contact Heidelberg Engineering Technical Support for assistance to rectify the 

issue.)

For reference, the Z module home positions specific on our HRA2 for 0 D (i.e. emmetropic) 

and −12 D (myopic) are “261” and “240”, respectively. Once the Z module parameter has 

been changed to the desired location the service mode window can be closed. The HRA2 

system should retain this configuration throughout the duration of the imaging session until 

the instrument is turned off or reset by the user in the service window. This modification 

adds a substantial amount of additional myopic correction (−150 D or more) that should now 

enable visualization of retinal vasculature IPI.

Fig. 1C–E, J shows representative fluorescence images of retinal vasculature in 

Tg(flk1:EGFP), Tg(flk1:mCherry), Tg(flk1:nGFP), and Tg(l-fabp:DBP-EGFP) zebrafish 

models. Fig. 1C and 1D show GFP and RFP expression in endothelial cell cytoplasm of 

Tg(flk1:EGFP) and Tg(flk1:mCherry) lines, respectively. The mCherry signal is weaker 

relative to the GFP since 488nm is not the optimal wavelength to employ for excitation of 

RFP. Fig. 1E shows EGFP expression in endothelial nuclei of retinal vasculature in 

Tg(flk1:nGFP) zebrafish. Note that distinct, individual, fluorescent protein expressing nuclei 

are easily resolved in Fig. 1E and that the reporter morphology is distinct from the lines 

expressing either GFP or RFP in the cytoplasm (Fig. 1C or 1D).
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Appreciable native signal contrast was also observed at the vitreoretinal interface using IR 

imaging mode (see Supplemental Video 1). At this interface, retinal vessels and nerve fibers 

could be imaged emanating from the optic disc. IRDF and RFDF modes were also capable 

of visualizing these features (images not shown). Measuring the optic nerve diameter (~200 

μm) from radial cryostat sections suggests that the SLO image FOV is ~1 mm (data not 

shown).

Autofluorescence mode (AF or FA) was useful for visualizing and investigating the retinal 

vasculature with either intraperitoneally injected NaF (Fig. 1F–I) or by imaging the Tg(l-

fabp:DBP-EGFP) model which has endogenous GFP-DBP (Fig. 1J) circulating throughout 

the vascular compartment. Fig. 1F–I is an example of the traditional method used for 

performing angiography in a small animal where the contrast agent (i.e. NaF) is injected via 

a readily accessible vein (i.e. tail vein of the mouse), or alternatively, into the intraperitoneal 

(IP) cavity. Fig. 1F–I shows a Tg(apoeb:lynEGFP)zf147 or “GFP-ApoE” fish that has 

undergone an IP injection of NaF (0.5 μl @ 1% v/v). Fig. 1F shows a baseline image of the 

native fluorescence from the GFP-ApoE that is expressed in nerve axons and neurosensory 

retina. The SLO focal plane has been positioned at the VRI, which shows retinal 

vasculature, contrasted against GFP fluorescence signal being returned from both adjacent 

nerve axons and Müller glia within the inner retina. The green fluorescent expression in the 

NFL, GCL, and IPL accentuates the retinal vasculature space, which appears dark against a 

green background (Fig. 1F). After injection, the vessels can be seen filling with NaF at 15 

(Fig. 1G), 30 (Fig. 1H) and 70 (Fig. 1I) seconds. Eventually, the NaF signal overwhelms the 

signal from the GFP-ApoE and as this happens, instrument gain must be changed to avoid 

signal saturation. As a result of the change in instrument sensitivity the GFP-ApoE signal 

fades in the image sequence and thus only the vasculature is seen in the final image (Fig. 1I). 

The use of a fluorescent label to accentuate the vitreoretinal interface (GFP-ApoE) greatly 

aids in performing these experiments because it allows the proper focal plane to be 

identified prior to NaF injection. However, despite our success with obtaining this 

“traditional” angiography data we found this to be a rather challenging task to routinely 

perform, especially in wild type fish with no GFP-ApoE label to serve as an initial 

alignment landmark. The small size of the fish coupled with the complications of injecting, 

all while simultaneously trying to image, proved to be tedious and very difficult to 

successfully perform on a consistent basis. Imaging the Tg(l-fabp:DBP-EGFP) line, on the 

other hand, was very simple (Fig. 1J, see Supplemental Video 2) as no injection of contrast 

agent is required.

A comparison between retinal angiograms of Tg(l-fabp:DBP-EGFP) zebrafish (Fig. 1J) and 

mice (Fig. 1K, L) injected with NaF (10μl @ 1% v/v, images collected 4 min post-IP 

injection) show substantial differences in vascular anatomy. Differences between zebrafish 

and mammals, including primates, have been previously reported (Alvarez et al., 2007). The 

zebrafish retina (Fig. 1J) lacks the superficial and deep vascular plexus that are prominent 

within the retina in mice (Fig. 1K, L). The zebrafish retinal vasculature (Fig. 1J) is restricted 

to the basal surface of the retina at the vitreoretinal interface. Because of the absence of 

intraretinal branches near the optic nerve, the vasculature of the zebrafish retina is 

significantly less complicated and congested than those from a mouse retina (Table 2). 

Bell et al. Page 9

Exp Eye Res. Author manuscript; available in PMC 2015 December 01.

N
IH

-P
A

 A
uthor M

anuscript
N

IH
-P

A
 A

uthor M
anuscript

N
IH

-P
A

 A
uthor M

anuscript



These anatomical differences make measuring and quantifying the signal magnitude of the 

extravascular space easier to perform and show that background levels in zebrafish are 

significantly lower than in mice (Table 2). Extravascular background in zebrafish is 

equivalent to the mouse superficial plexus but significantly lower (factor of 2) than the 

mouse deep vascular plexus. In theory, the lower background observed in zebrafish relative 

to mice should enhance the ability to discern and detect leakage from the retinal vessels in 

fish as compared to those in mice.

This difference in extravascular signal background between species likely originates from 

multiple known and some potentially still unknown sources. Examples that could potentially 

influence signal magnitude are: (1) Instrument gain - the SLO sensitivity setting can alter the 

measured signal magnitude(Charbel Issa et al., 2012), (2) Pupil size – smaller fish are 

observed to have smaller pupils which act as an aperture and reduce illumination and signal 

collection efficiency as demonstrated in mice if not fully dilated (Charbel Issa et al., 2012), 

(3) Fluorescent protein expression and/or labeling – variances in expression of GFP among 

individual animals could influence signal (Duval et al., 2013), (4) Endogenous 

autofluorescence- lipofuscin in the mouse RPE, which accumulates with age, is a strong 

contributor to background signal when imaging in AF mode (Sparrow et al., 2013) whereas 

in contrast, the rod OS and RPE in light adapted zebrafish are shielded by melansomes 

(Hodel et al., 2006) and the retina in our experience, qualitatively do not fluoresce in a 

similar manner and intensity as mouse RPE, (5) Ocular opacity- media opacities are known 

to quickly occur in anesthetized mice (Ridder et al., 2002), and have been reported in some 

zebrafish models (Tschopp et al., 2010); these can contribute to light scattering and alter 

signal measurements, and finally (6) Stray signal collection from regions outside the SLO 

focus – A stacked (i.e. from superficial, intermediate and deep vascular plexus regions) 

vascular plexus in the mouse (Paques et al., 2006) could cause signal collection overlap 

between measurements from each individual layer. Fluorescence signal bleeding through 

from intermediate and deep levels will influence measurements of avascular signal from the 

superficial plexus and vice versa, measurements of avascular signal from the deep plexus 

will be influenced by signal being collected that is before and/or after this layer, namely 

from the superficial and intermediate vessels. One must be cognizant of the fact that the 

confocal region of signal collection (i.e. region of confocality) is not a finitely confined 

plane within the tissue. Instead it is a three-dimensional, semi-finite geometry with both a 

diameter (x-y plane) and axial length (z-axis plane) signal collection zone that is dependent 

on various optical parameters. These parameters can include both the optical system design 

within the SLO (e.g. pinhole size) and the ocular characteristics of the species being imaged 

(e.g. ocular refractive power, pupil diameter, etc.)(Delori et al., 2011). In general, the 

smaller the pinhole the more confined the sample collection region and the more 

discrimination there will be against collecting indirect scattered light (Woon et al., 1992). 

The HRA2 has a pinhole that is 300–400 μm and is designed for use in the human eye 

(Maass et al., 2007). Regardless of the size, every pinhole permits some amount of signal to 

be collected from objects before and after the optimal plane of focus if that signal is 

overwhelming. This can be observed in Fig. 1L which shows image artifact as a result of the 

signal originating from objects (i.e. large primary vessels) outside the region of optimal 

focus. In this image, the instrument focus has been positioned for viewing of the mouse deep 
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vascular plexus. Stray light is still being collected from the large vessels, which are very 

bright due to the volume of GFP reporter contained within the vascular compartment. The 

vessels, which are located in front of the plane of focus, still contribute signal since one 

must image through the superficial plane to collect information from the deep plexus. This is 

why these vessels lack clear definition, as they are located outside the plane of focus. To our 

knowledge, no one has measured, calculated or modeled how the rodent and zebrafish eye 

influences the parameters (e.g. degree of confocality, axial and lateral resolutions, confocal 

region axial and lateral geometry and/or size, etc.) of this particular instrument that has 

specifications designed and reported for the human eye. This information, if obtained would 

be most helpful to many research labs that are heavily using these instruments to study 

numerous animal models. One group, however, has performed some system alterations so 

that their SLO it is better optimized for mice (Sparrow et al., 2013) and perhaps this could 

also be done specifically for zebrafish as well to further improve system performance.

Tg(l-fabp:DBP-EGFP) zebrafish, which express endogenously-fluorescent, circulating 

EGFP contrast agent, have been previously employed for studying vascular leakage (Xie et 

al., 2010). Here we demonstrate how this model, used in conjunction with an SLO, can be 

used to study and quantify vascular leakage induction after intraocular injections of 

biological proteins or protein peptides. Fig.2 shows the results from an experiment where we 

purposely injected NaF mixed with BSA (NaF + BSA) to induce a simulated vascular 

leakage episode. The purpose of this experiment was three-fold. First, we needed to inject a 

positive control (i.e. fluorescent agent) into the eye that we could validate our quantitative 

analysis methods developed for this model. Second, since our injection technique is 

performed by hand, we wanted to get some idea of our injection success rate. Third, we 

wanted to demonstrate that one could use a fluorophore, such as NaF, ICG or others mixed 

with the desired test agent being delivered to provide immediate, post-injection feedback on 

the success of the injection attempt.

Baseline (BL) images were collected on the first day from each animal. On the following 

day, animals were anesthetized and injected with NaF+BSA. Immediately post-injection 

(IPI), animals were briefly recovered for a few minutes (~3 min) and then re-anesthetized 

for imaging. Thereafter, the animals were imaged again at 1, 2 and 4 days post-injection 

(DPI). Three sets of images (Figs. 2A–O) from 3 different zebrafish injected with NaF+BSA 

represent our observations. The results from this experiment are shown graphically in Fig. 

2P. At BL, all zebrafish exhibited an ESMI that was ~15±10 grayscale units. Immediately 

after injection of NaF+BSA, the ESMI signal increased from between 2 (min) to 55-fold 

(max). On average, this change was significant (P=0.0185, Ordinary One-way ANOVA with 

Dunnett's Multiple Comparisons Test and adjusted P-value) relative to BL. Fig. 2A–E shows 

one animal that had the smallest change (2-fold) relative to the BL. IPI it can be seen that no 

increase in ESMI was documented (Fig. 2B), which essentially indicates that this particular 

injection was unsuccessful and no NaF was delivered. Figs. 2F–J demonstrates a typical (i.e. 

5 of 8 injected that were similar in response) IOI observed during this experiment which 

clearly shows a change in avascular space appearance and signal intensity relative to the 

adjacent retinal vasculature. This result represents a 5.5-fold increase in ESMI over that 

observed at BL. Figs. 2K–O shows an injection that was highly successful in delivering a 
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large bolus of NaF+BSA. In this example, the ESMI increased an astounding 55-fold and 

this appears to represent a “direct hit” into the vitreous chamber. In other cases it was 

obvious that the injection was subretinal as IPI imaging showed vascular plexus deformation 

caused by the injected fluid bleb (image not shown). IPI (Fig. 2L) it can be observed that the 

NaF signal originating from the extravascular space is brighter that the EGFP circulating in 

the retinal vessels. Only one day later the NaF has cleared from the posterior chamber as the 

elevated ESMI levels observed IPI have returned to near-BL levels.

In Fig. 2P the dotted line represents the limit for a grayscale level of 251 units which 

indicates the point at which detection saturation occurs with the HRA2. Data points beyond 

this line are extrapolated using the correction methods detailed in 2.3.3. This experiment has 

clearly demonstrated that our injections are successful the majority of times but also reveals 

that the bolus being delivered is variable in delivery location (IVT, subretinal, intraretinal or 

fails completely) from one animal to another. From these examples one can easily conclude 

that adding a small amount of fluorophore to the injection bolus serves as a helpful indictor 

for determining IOI success. Absence of dye would indicate that the injection was 

unsuccessful and that this animal could be eliminated from further experimental analysis 

consideration. Furthermore, we were able to see vessel deformation after some injections 

that we believe are from subretinal blebs. Thus, it appears as if this imaging method can 

distinguish between subretinal and intravitreal injections. The dye that would be the best 

candidate for this purpose would be ICG or alternatively, other dyes that have excitation and 

emission ranges that overlap with the ICGA channel of the HRA2. IR fluorophores of this 

nature would be better to use than NaF as it would not interfere with the EGFP signal 

already present in Tg(l-fabp:DBP-EGFP) zebrafish.

In a second experiment we aimed to determine whether intraocular injections with a benign 

protein could cause vascular leakage in Tg(l-fabp:DBP-EGFP). Results from this group 

were compared to another group of control animals conducted separately. In the control 

group, animals did not receive IOI but still underwent imaging at the second time point one 

day after BL images were collected (i.e. IPI). Representative examples of non-injected and 

BSA injected eyes are shown in Figs. 3A–E and Figs. 3F–J, respectively. In the non-injected 

control, no significant changes in ESMI were observed after repeated imaging sessions (Figs 

3A–E). In contrast, the group injected with BSA shows a significant increase at 1 DPI 

{P≤0.0001 relative to baseline (Ordinary One-way ANOVA with Dunnett's Multiple 

Comparisons Test and adjusted P-value) and P≤0.0001 relative to non-injected controls at 1 

DPI (Multiple t tests with significance determined by the Holm-Sidak method and 5% 

alpha)}. A visual example of this increase can be seen in Fig 2H, which makes the avascular 

space appear hazy relative to the baseline image (Fig. 3F). This observation persists through 

2 DPI, and occasionally 4 DPI, but was found to be insignificant relative to baseline. This 

experiment demonstrates that injection of a benign protein can induce a significant change in 

ESMI relative to BL. At this point it is unclear whether this leakage represents EGFP-

albumin leakage or if the injection has simply altered the background signal originating from 

the retina via some yet undocumented organ and/or tissue response (i.e. edema). Important 

to note is that no evidence of EGFP-albumin leakage occurred IPI on Day 2. The lack of an 

acute response suggests that the intraocular injection itself is not inducing EGFP leakage due 
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to vascular trauma (e.g. vessel rupture). Nevertheless, one must cognizant that injection 

trauma is a possibility at any time and could potentially influence experimental outcomes 

should it happen.

Fig 4 ultimately demonstrates the utility of applying SLO imaging to investigate vascular 

leakage in Tg(l-fabp:DBP-EGFP). In this experiment we tested a protein peptide known to 

induce vascular permeability compared to a separate group of BSA injected animals. Figs. 

4A–P show a panel of images that provide an example of the results observed with this 

experiment. Figs 4A–D, 4E–H, 4I–L & 4M–P are representative image examples from 

animals that received 20 ng of BSA or 20, 40 and 80 ng of BDK, respectively. BSA shows a 

moderate, but insignificant change in ESMI at 1 DPI relative to BL. There was one unusual 

outlier in the BSA treatment group (Fig. 4Q) this time that had an abnormally high response 

at 1 DPI (51.4 mean signal units @ 1 DPI vs. 14.6 units @ BL).

In the animals that received BDK we observed increased ESMI in each treatment group. 

Representative image examples from the 20, 40 and 80 ng treatment groups can be seen in 

Figs. 4E–H, 4I–L & 4M–P, respectively. The graphical representation of these results (Fig. 

4Q) shows that both 20 & 40 ng doses exhibited similar results at 1 DPI. The ESMI 

increased by 6.5-fold (up ~100 from ~15 @ BL) with both doses. Easily observed from the 

graphical data (Fig. 4Q) is the delineation between responding and non-responding animals. 

In the 20 & 40 ng treatment groups, 3/4th's and 2/3rd,s of animals, respectively, responded by 

showing obvious increases in ESMI. The ESMI of responders were clustered around 100 

grayscale units vs. virtually no amplitude change for non-responders relative to BL.

At doses of 20 (Figs. 4E–H) & 40 ng (Figs. 4I–L), a significant increase (P≤ 0.0001; Two-

way ANOVA with Dunnet's Multiple Comparisons Test) in ESMI was observed at 1 DPI. 

These elevated changes persist for another 24 hrs (2 DPI) but were fully resolved by 4 DPI. 

At 2 DPI, only the 20 ng treatment group was significant (P=0.0061). The group receiving 

80 ng BDK showed some evidence of leakage (Fig. 4N) but the mean difference (+21 mean 

grayscale units) over the BSA group was found to be insignificant. By 2 DPI, all animals in 

the 80 ng BDK group had returned to values similar to those observed at BL and with BSA 

controls at 2 DPI.

3.5 Post-Imaging Care

The contact lens is removed immediately post-imaging. The fish are then transferred to a 

small weigh boat filled with tank water, positioned on a tared microbalance, and weighed. 

Upon return to the tank, the fish was monitored visually for operculum movement. If 

operculum movement is suppressed or delayed, water is expelled across its gills using a 

disposable plastic pipette to expedite recovery.

The contact lens should be cleaned with water so that residual index matching fluid or 

contaminants will be removed in preparation for the next animal. As described in section 3.3 

above.
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4.0 Potential Pitfalls and Troubleshooting

Our group is able to successfully image the retinal vasculature of adult zebrafish on a routine 

basis using SLO. A method for successfully preparing, imaging and recovering fish, for 

either single or multiple imaging sessions is now routine. We experienced low mortality 

rates (3%) in a substantial cohort of fish (n=34). We discovered that imaging procedures 

involving fish are quite easy to perform relative to other popular small animal models like 

mice for the following reasons: (1) mydriatics are not required, (2) anesthesia is less 

complicated, (3) ocular clarity remained stable (i.e. no cataract or ocular opacities develop) 

throughout the duration of the imaging period, and (4) less time is required to complete the 

imaging. Despite these advantages, fish are still somewhat challenging because they: (1) 

have very small pupils and thus require more skill and dexterity to properly positioning the 

instruments in order to acquire images and (2) require an aqueous environment for survival 

and thus can only be kept out of water for a small amount of time (no more than 10 minutes 

maximum).

Finally, several key issues are important when attempting to image zebrafish:

4.1 Animal preparation

As with any animal, the proper anesthesia level is critical. A systematic approach is best for 

establishing and refining a routine. Keep track of successes and failures and correlate them 

to anesthesia dose and experiment durations for anesthesia induction, imaging session and 

recovery times. For novices it is helpful to have one or more people responsible for fish 

anesthesia, preparation and documentation while a second individual is performing the 

imaging.

4.2 Contact Lens Type, Placement and Care

Imaging the native fish eye without aid from a contact lens produced poor results (images 

not shown). In contrast, use of a periorbital-affixed contact lens was overwhelmingly 

successful and provided informative images of retinal morphology. Several different contact 

lenses were tested in an attempt to qualitatively determine which would perform the best. 

Thin and/or small lenses were more difficult to handle, hard to visualize and susceptible to 

being displaced from the animal if the anesthesia was inadequate. Under these circumstances 

a larger lens (5 vs. ~3 mm diameter) was easier to locate after being thrown off by an under-

anesthetized fish and handled on a regular basis for placement and removal. To accomplish 

successful imaging in fish it was not mandatory for the contact lens to be in direct contact 

and/or conforming to corneal surface. However, it was critically important to use a viscous 

or semi-viscous index matching fluid to (1) promote adhesion of the contact lens to the fish, 

and (2) eliminate the air bubbles from the space between the concave and convex surfaces of 

the contact lens and cornea, respectively. Our preferred fluid was Systane® Ultra, which 

permitted easy rinsing and cleaning of the lenses between imaging sessions. It was not 

critically important to have the contact lens perfectly centered over the eye. Often, the lens 

would be slightly off-center either in the caudal or nasal direction, but informative images 

could still be obtained. However, under this circumstance, one region of the retina would 

often have slightly better image quality than the other depending on which direction the 
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contact lens had shifted. Positioning asymmetry was easily addressed by manually 

repositioning the contact lens. This same approach was also performed when secondary, 

ghost images were observed of the retinal vasculature. Air bubbles in the index matching 

media or contaminants on the contact lens surface will cause duplication of detail (i.e. 

ghosting) in the images. In this case, a slight push or rotation of the contact lens would often 

rectify the problem. If this does not work then it was necessary to remove the lens, return the 

fish to its native environment, and clean the lens using a cotton-tipped applicator and clean 

water. Between daily imaging sessions the contact lens was disinfected using contact lens 

cleaning solution (Boston Simplus, Bausch & Lomb, Inc., Rochester, NY). Lens integrity 

and cleanliness was regularly inspected using a stereomicroscope (MZ9.5, Leica 

Microsystems, Buffalo Grove, IL) and cleaning was performed as needed. We have been 

using the same contact lenses (2 ea.) for several months involving more than several 

hundred individual fish imaging sessions. We have observed that the lens surfaces do 

become scratched over time due to handling with metal forceps but this does not seem to 

dramatically hinder image quality. At this time they appear to be capable of working 

indefinitely provided they are handled carefully and cleaned as aforementioned. Obviously, 

one will need to replace them at some point and take into consideration whether extended 

use may influence sensitive experiments involving quantitative measurements.

4.3 Animal Positioning

Positioning the fish quickly and efficiently is important. The SLIK model SBH-320 ball 

camera mount is invaluable for being able to position fish at the proper angle relative to the 

scanning SLO beam. Smaller fish are generally more difficult to image as clear access 

through the pupil is more challenging. Having a wide range in positioning freedom is 

advantageous. However, important to note is that it is not necessary to incorporate precise 

positioning mechanisms (i.e. micrometer actuated translation stages or positioning devices) 

to set up the fish for imaging. A crude mechanism, like the manually operated SBH-320 

mount, is ideal since it is quick at positioning the fish in the approximate location. 

Afterwards the precise, three dimensional (X, Y, Z) positioning capabilities within the SLO 

can be used to carefully and rapidly align the instrument with the eye and ocular features of 

interest.

4.4 User Proficiency and Experience

With all techniques and methods, practice improves data quality and can impact 

experimental outcomes. Multiple imaging sessions greatly improve one's ability to collect 

high quality images. Investigators just beginning to use this imaging technology on zebrafish 

should not start with valuable experimental specimens. It takes some time to acquire the 

skills required to perform the eye-hand coordination that will yield the best quality images, 

but this is quickly achieved with practice.

Supplementary Material

Refer to Web version on PubMed Central for supplementary material.
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Abbreviations

AF Autofluorescence

YAT Yen Auto-Threshold

ESMI Extravascular Space Mean Intensity

ESMA Extravascular Space Mean Area

BL Baseline

BSA Bovine Serum Albumin

BDK Bradykinin

CNV Choroidal Neovascularization

CFM Confocal microscopy

DPI Days Post-Injection

D Diopter

EGFP Enhanced Green Fluorescent Protein

FOV Field of view

GCL Ganglion cell layer

GFP Green fluorescent protein

HRA2 Heidelberg Retina Angiograph 2

IPI Immediate Post-Injection

ICG Indocyanine Green

ICGA Indocyanine Green Angiography

IRAF Infrared Autofluorescence

IRDF Infrared-Dark Field

IR Infrared Reflectance

IPL Inner Plexiform Layer

IOI Intraocular Injection

IVI Intravitreal Injection

MP Megapixel
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NFL Nerve Fiber Layer

OCT Optical Coherence Tomography

RFP Red Fluorescent Protein

RFDF Red Free-Dark Field

ROI Region of Interest

SLO Scanning Laser Ophthalmoscopy/Ophthalmoscope

NaF Sodium Fluorescein

FA Sodium Fluorescein Angiography

VRI Vitreoretinal Interface
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Figure 1. 
Photographs of the experimental setup used to perform SLO of adult zebrafish (Fig. 1A,B) 

and representative images from zebrafish (Fig. 1C–J) compared to mice (Fig. 1K, L). Fig. 

1A shows a fish prepared for imaging with a 5.2mm (Ø) PMMA contact lens (1) over the 

right eye. The fish is held upright between posts on the silicone finger mat (2). The mat also 

serves as a transportation aid to take the fish from the site of preimaging preparation (i.e. 

where the contact lens is applied) to the imaging instrument. The mat is placed on the 

positioning platform (3) and affixed to it using double-side tape (4). Scale bar = 1 cm. Fig. 

1B shows the fish in position directly in front of the objective lens (OL) for imaging the 

right eye. The setup includes an alignment positioning apparatus (APA) and positioning 

platform (3) for quickly orienting the animal and eye for image collection. SLO images 

(pseudo-colored green or red depending on fluorescent protein emission wavelength 

maxima) from Tg(flk1:EGFP)(Fig. 1C), Tg(flk1:mCherry)(Fig. 1D), Tg(flk1:nGFP)(Fig. 

1E), Tg(apoeb:lynEGFP)zf147 (Fig. 1F) and Tg(l-fabp:DBP-EGFP)(Fig. 1J) zebrafish show 

fluorescent protein expression of endothelial cell cytoplasm and nuclei, glia and DBP 

(albumin), respectively. In Fig 1C, some EGFP expression signal dropout can be seen 

(asterisk) which we occasionally observed in both endothelial nuclei and cytoplasm lines. 

Switching the instrument to IR mode and visualizing the vessels with this channel confirmed 

that the vasculature was still intact and functional (not shown). Angiography of a 

Tg(apoeb:lynEGFP)zf147 zebrafish (Fig. 1F–I) showing rapid filling of retinal vessels at 15 

(Fig. 1G), 30 (Fig. 1H) and 70 (Fig. 1I) seconds post IP injection of 1% NaF. A comparison 

between fluorescent images from Tg(l-fabp:DBP-EGFP)(Fig. 1J) zebrafish and mouse (Fig. 

1K–L) demonstrate the anatomical differences observed between species. Fig. 1K and 1L 

are FA images from the superficial and deep vascular plexus, respectively, from a normal 

Bell et al. Page 20

Exp Eye Res. Author manuscript; available in PMC 2015 December 01.

N
IH

-P
A

 A
uthor M

anuscript
N

IH
-P

A
 A

uthor M
anuscript

N
IH

-P
A

 A
uthor M

anuscript



wild type mouse shown for comparison to a zebrafish in which the plexus are nonexistent 

(Fig. 1J). The zebrafish avascular space is much less congested than the mouse since they 

lack numerous capillary and venule branching from primary and secondary vessels emerging 

for the optic nerve. This simplifies quantitative analysis, as less rigorous algorithms are 

required for segmentation of vascular and avascular regions. Theoretically, less congestion 

should also contribute to a lower avascular signal background for which to visualize and 

detect leakage.
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Figure 2. 
Representative images (Fig. 2A–O) and graphical results (Fig. 2P) from an experiment 

conducted to demonstrate the data collection and quantitative analysis methods developed 

for detecting vascular leakage in Tg(l-fabp:DBP-EGFP). In this group of animals (n=8), an 

intraocular injection of NaF+BSA (20ng, 0.8μl) was administered 1 day after BL imaging. 

Each animal was imaged immediately post-injection (IPI) to survey for the presence of NaF 

signal and then followed for 1, 2 & 4 days post-injection (DPI). Numbers on the lower left 

and right corners of each image represent the HRA2 camera sensitivity setting and the ESMI 

for that image, respectively. ESMI values that are italicized have been corrected using the 

methods outlined in Sec. 2.3.3. Figs. 2B, 2G, & 2L show examples of an unsuccessful, 

typical and highly successful IOI. IPI, NaF signal was observed in 7 out of 8 animals 

injected (88% success rate), however, the amount delivered was variable as we documented 

a 10-fold difference between minimum and maximum NaF signal magnitudes in typical 

(Fig. 2G) vs. highly (Fig. 2L) successful animals, respectively. The dotted line demarcates 

251 gray levels and the maximum intensity value that can be directly measured with the 

HRA2 8-bit camera photodetection system. Mean values shown above this line have been 

extrapolated using the correction methods detailed in Section 2.3.3. Note that NaF signal is 

not retained for long as it is completely cleared within 24 hrs. Data shown as a scatter plot 

with bars to indicate group time point means.
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Figure 3. 
Representative images (Fig. 3A–J) and graphical results (Fig. 3K) from an experiment 

involving IOI of BSA (20 ng, 0.8μl) in a group of Tg(l-fabp:DBP-EGFP) zebrafish 

compared to another group that did not receive injections. Fig. 3A–E and 3F–J show 

representative images collected from a non-injected and BSA-injected animal, respectively. 

Repeated imaging sessions in the injection-free group did not significantly change avascular 

space mean signal magnitude over time (Fig. 3K). In contrast, animals that received 

injections of BSA had a significant increase in mean signal magnitude at 1 DPI and can be 

observed in Fig. 3H as extravascular haze. This increase was significant relative to both the 

original mean baseline level on day 1, as well to the mean level observed at 1 DPI for the 

non-injected group. This response was brief and resolved within 24 hrs to an insignificant 

level at 2 DPI. Important to note is that no increase in ASMI was observed IPI, which 

demonstrates that the IOI does not cause acute damage resulting in leakage of EGFP-

albumin. Data shown as a scatter plot with bars to indicate group time point means. (Image 
notations: Lower left # − camera sensitivity setting; Lower Right # - ESMI; normal style 
text- ESMI obtained with sensitivity set @ 70, italicized text- ESMI was corrected).
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Figure 4. 
Representative images (Fig. 4A–P) and graphical results (Fig. 3Q) from an experiment 

involving intraocular injections of BSA (20 ng, 0.8μl) as a control protein and BDK (20, 40 

or 80ng, 0.8μl) in Tg(l-fabp:DBP-EGFP) zebrafish. Representative images from 20ng BSA 

and 20, 40 & 80ng of BDK can be observed in Figs. 4A–D, 4E–H, and 4I–L, respectively. 

One animal in the 40ng group died after baseline imaging. In this particular group of BSA 

treated animals (vs. the ones from Fig. 3), ASMI at 1 DPI was elevated relative to BL but 

not significant. Animals treated with BDK showed a significant response to treatment that 

could be easily observed at 1 DPI and moreover, the response carried over to 2 DPI. 

Leakage was observed in each treatment group but was significant only with 20 & 40 ng 

doses. This data also suggests an inverse dose response trend with BDK. This experiment 

shows the utility of this approach for the testing and screening of biological and chemical 

agents to study vascular permeability of the blood- retinal barrier. Data shown as a scatter 

plot with bars to indicate group time point means. (Image notations: Lower left # − camera 

sensitivity setting; Lower Right # - ESMI; normal style text- ESMI obtained with 

sensitivity set @ 70, italicized text- ESMI was corrected).
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Table 1

Characteristics of HRA2 SLO reflectance and angiography operating modes and sub-modes.

Reflection Mode (Dark field)

Mode Channels Channel (abbrev.) Laser Illumination 
Wavelength (nm)

Reflected Wavelength 
Collection (nm) Source of Reflected Signal

Infrared IRDF 815 815
reflected/scattered light (altered by tissue 

birefringence)
Red Free* RFDF 488 488

Angiography Mode

Mode Channels Channel (abbrev.) Laser Excitation 
Wavelength (nm)

Emission Collection 
Range (nm) Source of Emission Signal

Sodium Fluorescein FA 488 500–680 NaF fluorescence or native autofluorescence

Indocyanine Green ICGA 790 >800 ICG fluorescence or native autofluorescence

Infrared
† IR 815 815 reflected/scattered light

*
Red Free channel does not operate as a true dark field channel when used with the 55° Wide-field objective lens since the 488nm laser excitation 

beam emerging from the instrument is not 100% linearly polarized.

†
Infrared channel is not used as an angiography channel but falls into this category because of instrument design. This is an “open” channel that 

lacks any optical filtering to eliminate the illumination laser wavelength @ 815nm. Light collected with this channel is autoreflected from ocular 
tissue constituents.
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Table 2

A comparison between GFP and NaF angiography in zebrafish vs. mice. Mouse data was obtained from 

images collected at 4 min post- IP injection with 1% NaF. Zebrafish have more extravascular area for which to 

measure changes in extravascular leakage. Imaging system sensitivity (i.e. camera gain setting) was not 

significantly different between imaging groups and thus did not influence either extravascular area or intensity 

measurement comparisons. Data shown as Mean ± S.D and analyzed using an Ordinary one-way ANOVA 

with Dunnet's Multiple Comparisons Test.

SLO Image Characteristics
Zebrafish (n=10) Mouse (n=6)

superficial superficial deep

Extravascular Space Mean Area (%, range 0–100) 80.7 ± 1.9 60.5 ± 8.2**** 47.2 ± 92****

Extravascular Space Mean Intensity (grayscale units, range 0–251) 17.5 ± 8.9 23.8 ± 10.6n.s. 35.3 ± 12.6**

Camera Sensitivity Setting (console dial setting, range 31–107) 67.5 ± 2.1 67.2 ± 9.5 68 ± 7.8
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